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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2006 - 2008 Hewlett-Packard Development Company, L.P.

Trademark Notices

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California.

Windows® is a U.S. registered trademark of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

All other product names are the property of their respective trademark or service mark holders and are 
hereby acknowledged.
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Documentation Updates

To verify that the manual you are using is in fact the most recent edition, go to:

http://h20230.www2.hp.com/selfsolve/manuals

Locate the product, then look to see if a more recent edition of this document is available for downloading. If 
you subscribe to the appropriate product support service, you can arrange to have document updates sent to 
you. Contact your HP sales representative for details.

This edition of the OVO Report Pack User Guide includes the following changes:

• Chapter 1, Overview:

Added details about recent enhancements

Added section about metrics that are not available from OVOw

• Chapter 2, Installation and Configuration:

Added enable TCP/IP protocol for OMw 8.0

Minor edits throughout

• Chapter 4, Setting Up a Distributed System:

Revised overview re copy policy enhancement
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Support

Please visit the HP Software support web site at:

http://www.hp.com/managementsoftware/support 

This site provides contact information and details about the products, services, and support that HP Software 
offers.

Online software support provides customer self-solve capabilities. It provides a fast and efficient way to access 
interactive technical support tools needed to manage your business. As a valued support customer, you can 
benefit by using the support site to:

• Search for documents of interest

• Submit enhancement requests online

• Download software patches

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many also require a 
support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:

http://www.managementsoftware.hp.com/passport-registration.html
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1 Overview
This chapter covers the following topics:

• HP Performance Insight

• The OVO Report Pack

• Data Collection

• Folders and Reports

• Metrics Not Available from OVOw

• Background on OVO Message Generation

• Sources for Additional Information

HP Performance Insight

Performance Insight collects data from many sources, performs in-depth trend analysis, 
maintains performance baselines, and provides users with convenient, web-based reporting. 
Following is a partial list of product features:

• Distributed architecture

• Easy to scale (supports data collection from thousands of agents)

• CODA/OVPA agent support

• Multi-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Location Independent Reporting (LIR)

• Archiving via Long Term Retention (LTR)

• Multiple aggregation options (by hour, day, week, month; by location, by customer)

• Thresholding and alerting

• Easy identification of bottlenecks via top-10 ranking

• Easy identification of capacity trends

• Accurate and timely documentation for management

• Integration with Network Node Manager (NNM)

• Integration with OpenView Operations (OVO)
7



The reporting solutions created for Performance Insight cover many areas of business 
technology optimization. For details, see Appendix B, PI Report Packs.

The OVO Report Pack

The OVO Report Pack processes the following data from one or multiple OVOu servers:

• Message patterns based on OVOu and OVOw Active message tables

• Message patterns based on OVOu and OVOw History message tables

• Service status based on the OVOu and OVOw Service Log table

The OVO Report Pack maintains the follow data sets:

• Active Messages (currently unacknowledged)

• Active + History Messages (consolidated message reporting)

• Service Log

• Configuration

Each data set has four summary tables and four reporting views. (There is extensive use of 
object_byvar=yes in the property tables.) 

The OVO Report Pack offers these features:

• Multiple groups and roll-up combinations for:

— All OVO servers

— Node and Application

— Node and Template

— Server and Service

• Server configuration reporting

• Template and condition reporting

Enhancements in Version 1.2

Version 1.2 of the report pack includes defect fixes and this upgrade package:

• UPGRADE_OVO_to_12.ap

Version 1.1 of the OVO Datapipe collected data from OVOu servers only. Version 1.2 of the 
OVO Datapipe collects data from:

• OVOu 7.0

• OMu 8.0

• OVOw 7.5

• OMw 8.0

For details about defect fixes in version 1.2 of the report pack, see Appendix C, Version 
History.
8 Chapter 1



Data Collection

The data collection function works as follows:

• Modeled after the OVIS datapipe

• Written in JAVA

• References systems.xml

• Logs to trend.log

• Exports data to TSV (tab separated)

• Imports data using ee_collect

• Active snapshots are exported using views

Sybase Limitation

Due to a Sybase limitation in the length of the index, a serial number (identifier) is generated 
on three large text fields

• Service

• Application

• Condition description

Data Export

Data is exported in four distinct data sets

• Active Messages – Exports active message counts based on the following three groupings:

— Server Node - Application

— Server Node - Message Group

— Server Node - Service

• Consolidated Messages – Exports all new active and history messages since last collection

• Service Logs – Exports all service log entries since last collection

• Configuration – Once a day, the configuration for all trouble ticket and notification 
channels is exported

Why Consolidated Messages?

Consider this simple scenario (the “two-report problem”)

1 Fort Knox monitoring receives 200 events on January 10th

2 The operators only acknowledge 175 events leaving 25 events for the next day

3 At 6:45AM on January 11th, Andrew H. Card has one simple question. How many events 
came into the Fort Knox NOC?

The answer is in two reports: one report for the 25 remaining active messages and another 
report for the 175 acknowledged messages. Combined reporting solves the two-report 
problem, and this is how it works:

• Single report table in OVPI allows the reporting on all messages for the previous day

• An OVPI reaper process handles the active-to-history transition
Overview 9



Export Views

Export views are created with the following abbreviations

• A – Application

• M – Message Group

• N – Node

• O – Server

• S – Service

• U – User

• T – Template/Policy

• D – Condition Description

Examples:

• RV_OVO_MSG_BASE_A – View of R_OVO_MSG_BASE for rollups by Application

• RV_OVO_MSG_BASE_ON – View of R_OVO_MSG_BASE for rollups by Server and Node

• RV_OVO_MSG_BASE_OTD – View of R_OVO_MSG_BASE for rollups by Server, 
Template, and Condition

Folders and Reports

Installing the OVO Report Pack deploys the following report folders and reports:

Folder Contents

Active (14) • Message Severity by All Messages Trend
• Message Severity by Application Trend
• Message Severity by Message Group Trend
• Message Severity by Node and Service Trend
• Message Severity by Server
• Message Severity by Server and Application
• Message Severity by Server and Message Group Trend
• Message Severity by Server and Node Trend
• Message Severity by Server and Service Trend
• Message Severity by Server, Node, and Application Trend
• Message Severity by Server, Node, and Message Group Trend
• Message Severity by Server, Node, and Service Trend
• Message Severity by Service Trend
• OVO Server Summary

Message Weekly (3) • Weekly History Dashboard by Template
• Weekly History Dashboard by Template and Condition
• Last Week Dashboard by Server and Template
10 Chapter 1



Metrics Not Available from OVOw

The following metrics are collected from OVOu only:

• ESCALATE_FLAG

• IP_ADDRESS

Config (2) • Notif Channels 
• Trouble Ticket Channels 

Message (27) • History Dashboard by Server and Node
• History Dashboard by Server Node and Template
• Message Age Severity by Server and User Trend
• Message OVO Server Summary
• Message Severity by All Messages Trend
• Message Severity by Application Trend
• Message Severity by Message Group Trend
• Message Severity by Node Trend
• Message Severity by Node and Application Trend
• Message Severity by Node and Message Group Trend
• Message Severity by Node and Template Trend
• Message Severity by Node and Service Trend
• Message Severity by Server Trend
• Message Severity by Server and Application Trend
• Message Severity by Server and Message Group Trend
• Message Severity by Server and Node Trend
• Message Severity by Server and Service Trend
• Message Severity by Server and Template Trend
• Message Severity by Server and User Trend
• Message Severity by Server, Node, and Application Trend
• Message Severity by Server, Node, and Message Group Trend
• Message Severity by Server, Node, and Service Trend
• Message Severity by Server, Template and Condition Trend
• Message Severity by Service Trend
• Message Severity by Template Trend
• Message Severity by Template and Condition Trend
• Message Severity by User Trend
• Monthly Server Breakdown with Special Flags
• Server Breakdown with Special Flags
• Template Breakdown with Special Flags

Service Log • Severity Trend (Daily messages by services; by severity and 
duration details daily, weekly, and monthly)

Folder Contents
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• NOTIFY_SERVICES

• status_flag

• TEMPLATE_DESCRIPTION

The lack of these metrics has an impact on certain reports. If you are looking at an Active/
History Message report, the value in the Escalate field will always be zero. If you are looking at 
the Monthly Server Breakdown with Special Flags, or Server Breakdown with Special Flags, 
the following fields will always be zero:

• TT only

• Notify only

• TT & Notify only

Background on OVO Message Generation

Knowing how OVO generates messages is good background information. Here is the 
high-level sequence of events:

1 An event occurs on a managed object. The managed object creates a message.

2 The OVO agent on the managed node receives the message.

3 The message is compared to filters. Messages matching suppress conditions or duplicate 
messages are suppressed. Other messages are forwarded.

4 The message is logged locally.

5 Messages that match filters are converted to the OVO message format, and forwarded to 
the management server.

6 The management server processes the message by taking one of these actions:

• Assigns the message to another message group (regrouping).

• Starts non-local actions configured for the message on the specified node.

• Forwards the message to external notification interfaces and trouble ticket service.

• Escalates the message to another preconfigured management server.

• Buffers the message in the Pending Message Browser.

7 The active message is stored in the database.

8 The message displays in a Message Browser window.

9 When the message is acknowledged, it is removed from the active browser and put into 
the history database.

What are Active Messages?

• They are messages that have not been acknowledged by an OVO operator.

• They display in the OVO Message Browser.

• They reside in the opc_act_messages table.
12 Chapter 1



What are History Messages?

• They are messages that have been acknowledged.

• History messages are moved to the opc_hist_messages table for historical analysis.

What is a Message Group?

A message group is a convenient way to categorize messages. Messages belonging to the same 
function or task can be collected into a single group. For example, the message group Backup 
can contain all messages that relate to the backing up and storing of data (for example, 
messages originating from a network backup program, pieces of hardware used in the backup 
or storage operation, and so on). Message groups are then assigned to operators, who see and 
manage only those groups assigned to them. 

What is an Application?

An application can be a program, command, script, utility or service that the operator uses to 
maintain and control system and network services. For example, a backup program, and the 
process status command ps, can be integrated as applications.

Sources for Additional Information

The demo package that comes with the OVO Reporting contains a sample of each report in the 
package. If you have access to the demo package and you want to know what fully-populated 
reports look like, install the demo package. Like real reports, demo reports are interactive. 
Unlike real reports, the data in a demo report is static.

For details about known issues and recent enhancements, see OVO Reporting 1.2 Release 
Notes. Manuals for OVPI core, and manuals for the reporting solutions that run on OVPI core, 
can be downloaded from this site:

http://ovweb.external.hp.com/lpe/doc_serv/

The user guides for OVPI are listed under Performance Insight. The user guides for report 
packs and datapipes are listed under Performance Insight Report Packs. Each manual indicates 
a date. If a manual is revised and reposted, the date will change. Since we post revised 
manuals on a regular basis, be sure to compare your PDF to the PDF on the web and use the 
web version if it is newer.
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2 Installation and Configuration
This chapter covers the following topics: 

• Guidelines for a Smooth Install/Upgrade

• Using Package Manager to Install OVO Reporting

• Configuration Steps

Guidelines for a Smooth Install/Upgrade

An OVPI reporting solution has two ingredients, a report pack and a datapipe. Some reporting 
solutions include multiple datapipes. When you install the datapipe, you configure OVPI to 
collect a specific type of performance data at a specific interval. When you install the report 
pack, you configure OVPI to summarize and aggregate the data collected by the datapipe.

The report pack CD contains report packs, datapipes, shared packages, and documentation. If 
you, or someone else, extracted packages from the CD, then every package, including the OVO 
Report Pack and the OVO Datapipe, was copied to the Packages directory on your system and 
is now ready to install. Your next step is to launch Package Manager and follow the on-screen 
instructions. 

If you have not extracted packages from the report pack CD, do that now. You will find a CD/
package extract procedure later in this chapter. Extracting packages to the Packages directory 
launches Package Manager. Before using Package Manager to install OVO Reporting, be 
familiar with the prerequisites for OVO Reporting.

Supported Environments

The OVO Report Pack is designed to operate in the following environments:

OVPI Version Oracle Sybase

5.0 + SP3 9.0.2.4 11.9.2.5

5.1 + SP1 9.0.2.5 11.9.2.5

5.2 10g 15.0.1

5.3 10g 15.0.2
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Common Property Tables

If you are running an older version of Common Property Tables, you must upgrade to version 
3.7. If you are not running any version of Common Property Tables, Package Manager will 
install the latest version of Common Property Tables for you, automatically.

When you upgrade Common Property Tables, do not install the upgrade package and other 
packages at the same time. Instead, install the upgrade package for Common Property Tables 
and nothing else. Once Common Property Tables is upgraded, restart Package Manager and 
install more packages. For more information about Common Property Tables, refer to the 
Common Property Tables 3.7 User Guide.

Are You Upgrading to Version 1.2?

If you are upgrading, follow these steps:

1 Make sure that you have the latest version of Common Property Tables installed; if you 
are not running the latest version, upgrade to version 3.7.

2 Uninstall the previous release of the OVO Datapipe.

3 Restart Package Manager and install these packages at the same time:

• UPGRADE_OVO_to_12

• OVO Datapipe 1.2

Using Package Manager to Install OVO Reporting

This section explains how to install OVO Reporting fresh, for the first time. It covers the 
following tasks:

• Task 1: Extract packages from the report pack CD

• Task 2: If necessary, upgrade Common Property Tables

• Task 3: Start Package Manager and install these packages:

— OVO Reporting 1.2

— OVO Datapipe 1.2

Task 1: Extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu displays 
automatically; on UNIX, mount the CD, navigate to the top-level directory for the CD 
drive, and type the setup command. 
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4 Select OVPI report packs by typing 1 in the choice field and pressing Enter. The install 
script displays a percentage complete bar. When the extraction finishes, the install script 
starts Package Manager. The Package Manager welcome window opens.

If you navigate to the Packages directory on your system, you will see the following directory 
structure:

{DPIPE_HOME}/Packages/OVO_Reporting/OVO.ap

{DPIPE_HOME}/Packages/OVO_Reporting/OVO_Demo.ap

{DPIPE_HOME}/Packages/OVO_Reporting/OVO_Datapipe.ap

{DPIPE_HOME}/Packages/UPGRADE_OVO_Reporting_to_12.ap

If this is a new install, you can ignore the upgrade package. Installing the demo package is 
optional.

Task 2: Upgrade to Common Property Tables 3.7

When performing this upgrade, observe these rules:

• Do not install anything else; install the upgrade package and only the upgrade package. 

• When prompted to accept or disable the option to Deploy Reports, accept the default. If 
you do not deploy reports, you will not get the forms.

• When the install finishes, click Done to return to the Management Console.

Task 3: Install the OVO report pack and the OVO datapipe

1 If Package Manager is not running, select Tools > Package Manager from the Management 
Console. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or use the browse feature to select 
a different directory if necessary. 

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the default for application server name and port. Type your username and 
password for the OVPI Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following packages:

• OVO_Reporting 1.2 

• OVO_Datapipe 1.2

7 Click Next. The Type Discovery window opens. 

8 Disable the default to run Type Discovery immediately after package installation. 

9 Click Next. The Selection Summary window opens.

10 Click Install. The Installation Progress window opens and the install process begins. When 
the install finishes, a package install complete message appears. 

11 Click Done to return to the Management Console. 

12 Restart OVPI Timer.

OVO Reporting does not require Type Discovery. If you are installing other report 
packs in addition to OVO Reporting, you may need to run Type Discovery for those 
packages. 
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Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Configuration Steps

Once the report pack is installed, perform these configuration steps related to the OVO 
database:

• Enable the TCP/IP protocol on all OMw 8.0 servers (applies to OMw 8.0 servers only)

• Set Up a Connection to the OVO database

• Register OVO servers with the OVO Datapipe (add each system name to the .prp file)

• Configure OVO for Active Message Export

Task 1: Open the TCP/IP Protocol on the OMw Server (applies to OMw 8.0 only)

1 Select Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools > SQL Server 
configuration Manager.

2 The SQL Server Configuration Manager window opens.

3 Select Protocols for OVOPS. In the panel on the right, select TCP/IP.
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4 The TCP/IP Properties window opens.

5 In the Protocol tab, opposite Enabled, select Yes. The TCP/IP protocol is now enabled.

6 Select the IP Addresses tab.
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7 Set all Active to Yes.

8 Set all Enabled to Yes.

9 Do not modify the IP Address field.

10 Set TCP Dynamic Ports to null.

11 Set the TCP port to any port number, ensuring no port conflict. An MS SQL server usually 
uses port 1433.

12 Click Apply to apply your changes.

13 Click OK to close pop-up window.

14 Restart the MS SQL service.
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Task 2: Add an External OVO Database to OVPI

The OVPI server cannot connect to the OVO database unless it has the information it needs to 
make the connection. Supply this information by running the Add Database Wizard.

Follow these steps to connect OVPI to the OVO database:

1 Start the Management Console and login as the OVPI administrator.

2 Click the Systems icon on the lower left. The System/Network Administration pane opens.

3 In the center pane under the System Information folder, open the folder representing the 
local OVPI server.
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4 Right-click Databases and select Add OVPI Database. The Add Database Wizard opens. 

5 Click Next. The Type of Database window opens. 

6 Select Generic Supported Database and click Next.
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7 In the Database Connectivity Information window, add information about the OVO 
database. 

For an OVOu Database:

a Hostname: IP Hostname of the OVOu server

b Port: port the database is listening on

c Vendor: Oracle

d Database Instance: SID of OVO database

e Database Username: OVO database login

f Password: OVO database password for login

For an OVOw Database:

a Port: the SQL Server port

b Vendor: SQLServer

c Windows Authentication: check this box (OMw 8.0 only)

d Domain: the domain on the Windows account (OMw 8.0 only)

e Window Username: the Windows account username. The Windows account username 
must have permission to access MS SQL Server Express (shipped with OMw 8.0).

f Password: the Windows account password, not the database password
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8 Click Next. The Identify System window opens. 

9 Type a name and a description. 

You may use the hostname as the name. Use any name that is meaningful to you.

The name you specify here will appear in the <Name> field in the systems.xml file, and in 
reports. The OVO Datapipe will use the name you specify here to locate connectivity 
information for the OVO database.
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10 Click Next. The Summary Page window opens.

11 Review the contents of the Summary Page. If everything is okay, click Finish.
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12 Verify that the connection you just added is recognized by OVPI by selecting the new 
database in the System/Network Administration pane. Review the connectivity 
parameters.

13 Click the Test Connection button to verify that OVPI can connect to the OVO database.
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Task 3: Register OVO Servers with the OVO Datapipe

Add each system to the appropriate .prp file:

All four .prp files were added to the data directory when you installed the report pack. The 
OVO Datapipe uses the .prp file to determine which OVO databases it will collect data from 
and how to connect to each database.

Register each server by adding to the file one line for each OVO server you want to collect 
from. If you are collecting from multiple servers, list each server on a separate line. If you are 
collecting from a single OVO server, the file will contain one line. No other information is 
allowed in this file. Do not insert comments or any other information.

Each name you add to this file must match the name you typed in the Identify System 
window. The OVO Datapipe will use these names to locate connectivity information in the 
systems.xml file. These names will also appear in reports. 

Task 4: Configuring OVO for Active Message Export

The OVO Datapipe does not export messages from the Active Message table. Instead, it takes 
a snapshot of current Active Message statistics and then summarizes the results to hourly, 
daily, weekly, and monthly levels. The results are similar to HISTORY statistics. The 
difference is that taking a snapshot of current statistics produces a summary of “Current 
Active Messages” as compared to “New HISTORY”.

To make the snapshot of current Active Message statistics possible, you must create three 
separate export views on the OVO database. The OVO Report Pack rollup generates 
additional levels of data from the data provided by the export views.

The following export views are created for the element level indicated:

OVPI_ACT_ONA:OVO_SERVER – NODE_NAME – APPLICATION

OVPI_ACT_ONS:OVO_SERVER – NODE_NAME – SERVICE_NAME 

OVPI_ACT_ONM:OVO_SERVER – NODE_NAME – MSG_GROUP

Until you create these views, current Active Message statistics will not be exported from that 
OVO server. Follow these steps to create views:

1 Login to the OVPI server as the OVPI administrator (trendadm on Unix).

2 Execute the following command at the command line:

ovo_datapipe -dataset create_view –database <nsprod1> –server <u8>

File Function

{DPIPE_HOME}/data/ovou8servers.prp List of OVOu 8.0 servers

{DPIPE_HOME}/data/ovou7servers.prp List of OVOu 7.0 servers

{DPIPE_HOME}/data/ovow8servers.prp List of OMw 8.0 servers 

{DPIPE_HOME}/data/ovow7servers.prp List of OVO 7.5 servers

{DPIPE_HOME}/data/systems.xml Connectivity details for each database
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For each OVO database listed in .prp file, four blocks of messages will be printed on the 
command line. The messages indicate that SQL statements are being executed to create four 
table views in each OVO database.

How the Export Program Operates

The OVO export program connects to the OVO database and exports information from 
Consolidated and Service Log tables. When the export process runs for the second time, only 
new records will be exported from the tables.

The export process is driven by an OVPI trend_proc batch file. After installation, the file will 
be located in the following location:

{DPIPE_HOME}/scripts/OVO_Datapipe_Hourly.pro

This file drives three separate export processes, one for each of the three required OVOu 
datasets. Here is the executable command for each dataset:

ovo_datapipe -dataset MSG

ovo_datapipe -dataset SRV_LOG

ovo_datapipe -dataset ACT

The name of the export program is ovo_datapipe. Although the program has several 
configurable parameters (see below), in most cases only the -dataset parameter is needed. 
The following files contain the information that the ovo_datapipe export program requires to 
connect to each OVO database:

If the -dataset option is the only option specified when the ovo_datapipe process is 
initiated, ovo_datapipe will collect data from every OVO server listed in the ovou and ovow 
.prp files. The ovo_datapipe process will use the list of servers in the ovou and ovow .prp files 
to locate connectivity information in the systems.xml file.

If the views fail to create, verify that you have permission to create and drop views.

File Function

{DPIPE_HOME}/data/ovou8servers.prp List of OVOu8 servers

{DPIPE_HOME}/data/ovou7servers.prp List of OVOu7 servers

{DPIPE_HOME}/data/ovow8servers.prp List of OVOw8 servers

{DPIPE_HOME}/data/ovow7servers.prp List of OVOw7 servers

{DPIPE_HOME}/data/systems.xml Connectivity details for each database
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Export Program Parameters

The OVOu export process is flexible. The following table describes each parameter.

The first time the export process runs, an excessive amount of data can be exported from the 
OVO database if the process is allowed to go back too far to locate records to export. If desired, 
you can limit the amount of data that will be exported by configuring the OVO datapipe to go 
back a specific number of days. If you do not specify a value for this parameter, the export will 
adhere to the default, which is to export messages no older than midnight of the previous day.

Parameter Description

-dataset <ACT|MSG|CFG|SRV_LOG|create_view|drop_view>
ACT: export OVO Active Message Statistics.
HIST: export OVO Consolidated Messages.
CFG: export OVO channel configuration.
SRV_LOG: export OVO Service Log records.
create_view: create OVO Active Message Statistics database views.
drop_view: remove OVO Active Message Statistics database views.

-database “Name” of OVO server to connect to and export OVO data from. The 
specified name must match an entry in OVPI’s systems.xml file 
based on the “<Name>” tag field in the systems.xml file. This must 
also match an entry in the .prp file.
Normally, no OVO server will be specified and data will be collected 
from all OVO servers listed in the .prp file.

-datadir By default, data is exported to $DPIPE_HOME/data/ImportData/
OVO_Reporting. A different location can be specified using this 
option.

-prevdays Specifies the number of days prior to today to collect data inclusive 
of today. Only used if the previous collection time is not stored in the 
maxtime <TIME_TABLE>_<TIME_FIELD> file or for the first 
execution. The default value is 1 day. This parameter only applies to 
History and Service log data.

-debug Set for Debug output.

-help Display help information.

-version Display ovo_datapipe version.

-V Display ovo_datapipe version.

-server Either u8, u7, w8, or w7, corresponding to the database specified by 
-database
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The -prevdays option does not apply to all datasets. For example, the OVO Active Message 
table export process does not actually export message records. Instead, a small number of 
records are captured that provide a snapshot of “current” record statistics for the OVO Active 
Message table. In this case there is no need to specify a maximum number of days to include 
in the export process.

Testing the Export Process

Run the following command to test the export process:

ovo_datapipe –database <XYZ> –server <u7> –dataset ACT

To view the results, navigate to the following directory:

data/ImportData/OVO_Reporting

— Oracle SID for the OVO database

— OVO database user name

— OVO database user password

OVO export files are imported into PI and then deleted by default. If archiving is enabled, you 
can avoid filling up the filesystem by setting up a process to clean out the export files. Clean 
the export files from the following location on the PI server:

{DPIPE_HOME}/data/ImportData/OVO_Reporting/Archive
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3 Verification Steps
This chapter will help you confirm that OVO Reporting is properly installed and working 
correctly. It answers the following questions: 

• Does trendtimer.sched contain collection and rollup entries?

• Did the reports deploy as expected during package installation?

• Is the data export program working?

• Is OVPI importing data?

• Are the hourly tables being populated?

• Are the daily tables being populated?

• How can I remove the OVO report pack?

Following the verification steps in this chapter is not mandatory. Skip them unless you have 
reason to believe that something is not working properly.

Collection and Rollup Entries in trendtimer.sched

The installation process adds entries to trendtimer.sched to ensure that processes are 
executed as needed by trendtimer. The following entries are added to trendtimer.sched:

# HP OVO Reporting Project

1:00+5 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/OVO_Datapipe_Hourly.pro

24:00+2:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/OVO_Datapipe_Daily.pro

### OVO Reporting Daily Processing

24:00+8:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/Daily_OVO_Rollup.pro

Correct Deployment of Reports

If the deploy reports options was selected during the installation process, the reports were 
deployed to the OVPI server you specified. To verify that the reports deployed as expected, 
check this directory:

{DPIPE_HOME}/reports/deploy/system/OVO_Reporting
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The Data Export Program is Working

Data collection will take place for the first time at 5 minutes past the hour (1:00+5 - -), in 
accordance with entries added to trendtimer.sched for data collection when OVO Reporting 
was installed. This process exports records from the OVO database into flat files on the PI 
server. The OVO data is later imported into the PI database and summarized by the daily 
rollup process specific to each dataset.

The following command can be executed at the command line to initiate the ovo_datapipe 
export process manually:

trend_proc -f {DPIPE_HOME}/scripts/OVO_Datapipe_Hourly.pro

After the successful completion of the above command, the exported data should be located in 
the following directory:

{DPIPE_HOME}/data/ImportData/OVO_Reporting

The exported OVO data in that directory should be in files with names similar to the 
following:

OVO_ACT_ONA_<ovo server name>_<date>_<time>.dat

OVO_ACT_ONM_<ovo server name>_<date>_<time>.dat

OVO_ACT_ONS_<ovo server name>_<date>_<time>.dat

OVO_MSG_HIST_<ovo server name>_<date>_<time>.dat

OVO_MSG_ACT_<ovo server name>_<date>_<time>.dat

OVO_SRV_LOG_<ovo server name>_<date>_<time>.dat

OVO_CFG_LOG_<ovo server name>_<date>_<time>.dat

OVPI Is Importing Data

The OVO data is imported into the PI database by the daily rollup process specific to each 
dataset. Each daily rollup process imports the appropriate dataset files and then steps 
through the rollup of that dataset.

The import process will populate the following data tables in the PI database with records.

The first time the ovou_datapipe program runs, by default, the program exports data records 
received since midnight of the previous day. If desired, you may override the default. To force 
the export process to include records from further back in time, use the -prevday option and 
specify the number of days. This parameter only affects the first time the export program is 
executed for a specific dataset. After that, the export program keeps track of the last exported 
timestamps and only exports the records that arrived since the previous export.

If this option is desired, add the -prevday option to the ovou_datapipe statements before 
executing the datapipe the first time. If there are any timestamp files in {DPIPE_HOME}/
Data/ImportData/OVO_Reporting, these timestamp files will override the -prevday 
option. They must be deleted for the -prevday option to work.

The data is imported into PI once per day as part of the daily rollup process.
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• R_OVO_MSG_BASE

• R_OVO_ACT_BASE

• R_OVO_SRVLOG_BASE

• R_OVO_CONFIG_BASE

Verify this in Table Manager by navigating to the OVO_Reporting Category and locating the 
tables listed above.

The oldest and most recent time stamps can be determined for the import tables by executing 
the following SQL statement in SQLplus, ISQL, or SQL Advantage:

select ‘R_OVO_MSG_BASE’, min(ta_period), max(ta_period) from R_OVO_MSG_BASE

select ‘R_OVO_ACT_BASE’, min(ta_period), max(ta_period) from R_OVO_ACT_BASE

select ‘R_OVO_SRVLOG_BASE’, min(ta_period), max(ta_period) from R_OVO_SRVLOG_BASE

select ‘R_OVO_CONFIG_BASE’, min(ta_period), max(ta_period) from R_OVO_CONFIG_BASE

This should return valid date/times in the second and third column if data has been imported.

The OVO export files should have been archived to the following location by the OVPI data 
import process:

{DPIPE_HOME}/data/ImportData/OVO_Reporting/Archive

If the OVO export files are in the “OVO_Reporting” directory but not in the “Archive” 
directory, the OVO export ran successfully but the import process was not successful. You will 
find errors relating to the import process in this file:

{DPIPE_HOME}/log/trend.log

The Hourly Data Tables Are Populated

After several hours of data have been imported into OVO Report Pack base tables in the PI 
database, the hourly rollup process can be initiated as follows:

1 Change directory to {DPIPE_HOME}/scripts

2 Execute the following commands:

a trend_proc -f Daily_OVO_ACT_Rollup.pro

b trend_proc -f Daily_OVO_MSG_Rollup.pro

c trend_proc -f Daily_OVO_SRVLOG_Rollup.pro

d trend_proc -f Daily_OVO_CFG_Rollup.pro

3 Use Table Manager to verify that the hourly data tables have been populated, or execute 
the following SQL statements:

select ‘SH_OVO_MSG’, min(ta_period), max(ta_period) from SH_OVO_MSG

select ‘SH_OVO_ACT’, min(ta_period), max(ta_period) from SH_OVO_ACT

Records will only be added to these tables if the OVO server has received new records for 
those datasets.
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If data was rolled up to the hourly level, these statements should return valid date/times 
in the second and third column.

The Daily Tables Are Populated

After a complete day of data has been imported into the OVO Report Pack’s Base tables within 
the OVPI database, the daily rollup process can be initiated again using the same command 
as specified above:

1 Change directory to {DPIPE_HOME}/scripts

2 Execute the following commands:

a trend_proc -f Daily_OVO_ACT_Rollup.pro

b trend_proc -f Daily_OVO_MSG_Rollup.pro

c trend_proc -f Daily_OVO_SRVLOG_Rollup.pro

d trend_proc -f Daily_OVO_CFG_Rollup.pro

3 Use Table Manager to verify that the daily data tables were populated, or execute the 
following SQL statements:

a select ‘SD_OVO_MSG’, min(ta_period), max(ta_period) from SD_OVO_MSG

b select ‘SD_OVO_ACT’, min(ta_period), max(ta_period) from SD_OVO_ACT

c select ‘SD_OVO_SRVLOG’, min(ta_period), max(ta_period) from SD_OVO_SRVLOG

If data rolled up to the daily level, these statements should return valid date/times in the 
second and third column.

The daily rollup processes also force the summarization to the weekly, monthly, and baseline 
level, if enough time has passed and enough data has been collected to summarize to those 
levels. Data can only rollup to the next time interval when the time period is complete. For 
example, monthly data for the month we are in now will not be generated until the present 
month has ended.

Verify those tables using the following SQL statements:

select ‘SW_OVO_MSG’, min(ta_period), max(ta_period) from SW_OVO_MSG

select ‘SM_OVO_MSG’, min(ta_period), max(ta_period) from SM_OVO_MSG

select ‘SW_OVO_ACT’, min(ta_period), max(ta_period) from SW_OVO_ACT

select ‘SM_OVO_ACT’, min(ta_period), max(ta_period) from SM_OVO_ACT

select ‘SW_OVO_SRVLOG’, min(ta_period), max(ta_period) from SW_OVO_SRVLOG

select ‘SM_OVO_SRVLOG’, min(ta_period), max(ta_period) from SM_OVO_SRVLOG

The individual steps of any trend_proc file can be executed at the command line as 
long as the environment variables are defined correctly and slashes are in the 
correct direction (/).
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Uninstalling the OVO Report Pack

Follow these steps to uninstall the OVO Report Pack.

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens.

7 If Application Server reports were deployed from this server, accept the defaults for 
Undeploy Reports, Application Server Name, and Port. If Application Server reports were 
not deployed from this server, clear the check box and skip to step 9.

8 Type the username and password for the OVPI Application Server.

9 Click Next. The Package Selection window opens. 

10 Click the check boxes next to the following packages, if they appear in the list:

• OVO Reporting 1.2

• OVO Datapipe 1.2

11 Click Next. The Selection Summary window opens. 

12 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

13 Click Done to return to the Management Console.

14 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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4 Setting Up a Distributed System
This chapter covers the following topics;

• Overview of the steps involved in setting up a distributed system

• Checking for proper package installation

• Splitting device groups

• Configuring the central server

• Configuring a satellite server

Overview of the Steps

Follow these steps when setting up a distributed system:

1 Decide whether you want local reporting or central reporting.

2 Install the right set of packages on each server (a central server that is not polling will not 
need datapipes; the satellite servers will need datapipes).

3 Verify that the system clocks in your environment are synchronized.

4 Register your satellite servers.

5 If you are not copying rate data to the central server, enable LIR on the central server.

6 If you enable LIR, add LIR mapping with the time type set to rate.

7 Verify that you have all the copy policies you need.

8 Configure the central server (manual edits to trendtimer.sched and .pro files).

9 Configure each satellite server (manual edits to trendtimer.sched and .pro files).

If you want local reporting, you need to deploy reports when you install the report pack on 
each satellite server, and you also need to allow summarizations to run on each satellite 
server. If you do not want local reporting, then you do not need to deploy reports when you 
install a report pack on a satellite server, and you can disable the scripts that run 
summarizations on each satellite server.

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. This approach had two benefits. It kept a lot of rate data off 
the network, and it decreased the processing load on the central server. The problem with this 
approach is that the central server could not display a Near Real Time (NRT) report. The only 
NRT report was a local NRT report, on a satellite server. 
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LIR fixes this problem. If you enable LIR, you can open an NRT report on the central server 
and drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do, then enabling LIR is not necessary.

Interface Reporting now comes with a copy policy import file. When you install Interface 
Reporting, PI uses this file to generate copy policies. Creating these policies yourself, using 
the Management Console, is no longer necessary. Your only task is to verify that you have 
copy policies for the following tables:

• SD_OVO_SRVLOG

• SH_OVO_MSG

• R_OVO_CONFIG_BASE

• SH_OVO_ACT

Because you are likely to have multiple satellite servers, we designed the hourly process files 
to be satellite-server friendly. This means that most of the time, most of the defaults are 
correct. But some defaults will be incorrect, or less than optimal, and to improve performance, 
you should change them. These manual edits, as well as the other steps listed above, are 
spelled out in detail in this chapter.

Verifying Correct Package Installation

Verify that you have the right packages installed on each server. 

Packages on the Central Server

• OVO Report Pack, with reports deployed

• Common Property Tables, with forms deployed

Packages on Each Satellite Server

• OVO Report Pack 

• Common Property Tables 

• OVO Datapipe

Typically, the central server does not poll. If you want the central server in your system to 
poll, install a datapipe on the central server. If you want to view reports on satellite servers 
(local reporting) accept the Deploy Reports option when you install report packs at each 
satellite server. If central server reporting is the only reporting you want, you do not need to 
deploy reports and forms when you install report packs at satellite servers. 

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Register the satellite server by setting the database role

• Task 2: If you are not copying rate data to the central server, enable LIR 

• Task 3: If you enable LIR, add LIR mappings
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• Task 4: Verify the automatically generated copy policies

• Task 5: Edit trendtimer.sched and multiple process files

For more information about LIR and copy policies, refer to the HP Performance Insight 
Administration Guide.

Task 1: Register the satellite server by setting the database role

Follow these steps to register a satellite server:

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the database system.

4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

Task 2: Enable LIR

Follow these steps to enable LIR:

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: Add LIR mappings

Follow these steps to configure LIR mappings: 

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

7 Select the Category data table option.

8 Select OVO from the drop down list.

9 Select the rate data type.

10 Click Add to List.

11 Click OK.

12 Click Apply.

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.
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A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type you select determines the type of data copied. The type of data copied 
(defined in the generated copy policy) is one summarization level greater than the data type 
selected in the LIR mapping. For example, if you select an hourly data type, you will generate 
a daily data copy policy.

Task 4: Verify the automatically generated copy policies

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 The following tables should appear in the copy policy list:

• SD_OVO_SRVLOG

• SH_OVO_MSG

• R_OVO_CONFIG_BASE

• SH_OVO_ACT

For each table, verify that copy type is set to Property and Data.

4 If a copy policy has not been generated for any of the tables listed above, click the New 
Copy Policy icon or select File > New Copy Policy from the Copy Policy Manager. The Copy 
Policy Wizard opens.

5 Click Next. The Satellite Server and Copy Policy Selection Page opens.

6 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

7 Select Single Table and select the table from the pull down list.

8 Click Next. The Copy Type Selection Page opens.

9 Select Property and Data.

10 Click Next. The Summary page opens.

11 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.

12 Click Finish.

13 Repeat step 4 - step 12 for all missing tables.

If only the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5: Edit trendtimer.sched and multiple process files.

1 Change the trendtimer.sched file located in {DPIPE_HOME}/lib for the central server 
from this:

## 24:00+8:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
Daily_OVO_Rollup.pro
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to this:

## 24:00+9:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
Daily_OVO_Rollup.pro 

2 Edit the Daily_OVO_MSG_Rollup.pro file:

• Comment out block 1, 

3 Edit the Daily_OVO_ACT_Rollup.pro file:

• Comment block 1,

4 Edit the Daily_OVO_SRVLOG_Rollup.pro file:

• Comment out block 1,

5 Edit the Daily_OVO_CONFIG_Rollup.pro file:

• Comment out block2,

Configuring Satellite Servers

Configure each satellite server by enabling copy commands that are disabled by default. Once 
the copy commands are enabled, the central server will handle the summarizations. The copy 
commands appear in hourly process files in the Scripts directory. Make the following changes 
to four process files:

1 Open the Daily_OVO_MSG_Rollup.pro file:

a Uncomment block 2

b Comment out block 3 

c Change block 2 to 

begin: block2 wait
{DPIPE_HOME}/bin/trendcopy -t SH_OVO_MSG
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_LOOKUP_D
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_LOOKUP_S
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_LOOKUP_A
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_BASE
{DPIPE_HOME}/bin/trendcopy -t SD_OVO_MSG
end: block2 

2 Open the Daily_OVO_ACT_Rollup.pro file:

a Uncomment block 2

b Comment out block 3

c Change block 2 to: 

begin: block2 wait
{DPIPE_HOME}/bin/trendcopy -t SH_OVO_ACT
{DPIPE_HOME}/bin/trendcopy -t R_OVO_ACT_BASE
end: block2 
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3 Open the Daily_OVO_SRVLOG_Rollup.pro file:

a Uncomment block 2

b Comment out block 3

4 Open the Daily_OVO_CONFIG_Rollup.pro file:

• Uncomment block 2

System Clocks

Make sure the system clock on each satellite server is synchronized with the system clock on 
the central server. 
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5 Active Message Reports
The following reports contain information about current unacknowledged messages.

1. OVO Server Summary (see sample page 41)

Provides total number of messages and severity details for each management server; for a 
selected management server, provides statistics for severity, age, and duplicates daily, weekly 
and monthly.

2. Message Severity Trend by All Messages (see sample page 43)

Provides a summary of all messages across all management servers by severity; includes 
statistics for message age, severity, volume, duplicates, and special flag counts hourly, daily, 
weekly and monthly.

3. Message Severity Trend by Application

A list of 15 applications with the most associated messages; includes the following details for 
the selected application: Message age, severity, volume, duplicates, and special flag counts 
hourly, daily, weekly and monthly.

4. Message Severity Trend by Message Group

A list of 15 message groups with the most associated messages; includes the following details 
for a selected message group: Message age, severity, volume, duplicates, and special flag 
counts hourly, daily, weekly and monthly.

5. Message Severity Trend by Node and Service

A list of 15 nodes, and corresponding services running on those nodes, with the most 
associated messages; includes the following details for a selected node and service pair: 
Message age, severity, volume, duplicates, and special flag counts hourly, daily, weekly and 
monthly.

6. Message Severity Trend by Server

A list of 15 management servers that have the most associated messages, with the following 
details for a selected Operations management server: message age, severity, volume, 
duplicates, and special flag counts hourly, daily, weekly and monthly.

7. Message Severity by Server and Application

A list of 15 management servers, and corresponding applications being managed by those 
servers, that have the most associated messages; include the following details for a selected 
management server and application pair: Message age, severity, volume, duplicates, and 
special flag counts hourly, daily, weekly and monthly.
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8. Message Severity by Server and Message

A list of 15 management servers, and corresponding message groups being monitored by those 
servers, that have the most associated messages; includes the following details for a selected 
management server and message group pair: Message age, severity, volume, duplicates, and 
special flag counts hourly, daily, weekly and monthly.

9. Message Severity by Server and Node

A list of the 15 management servers, and corresponding nodes being managed by those 
servers, that have the most associated messages; includes the following details for a selected 
management server and node pair: Message age, severity, volume, duplicates, and special flag 
counts hourly, daily, weekly and monthly.

10. Message Severity by Server and Service

A list of 15 management servers, and corresponding services being managed by those servers, 
that have the most associated messages; includes the following details for a selected 
management server and service pair: Message age, severity, volume, duplicates, and special 
flag counts hourly, daily, weekly and monthly.

11. Message Severity by Server, Node and Application 

A list of 15 management servers, and corresponding nodes and applications on those nodes, 
that have the most associated messages; includes the following details for a selected 
management server, node and application: Message age, severity, volume, duplicates, and 
special flag counts hourly, daily, weekly and monthly.

12. Message Severity by Server, Node, and Message Group

A list of 15 management servers, and corresponding nodes and message groups from those 
nodes, that have the most associated messages; includes the following details for a selected 
management server, node and message count threesome: Message age, severity, volume, 
duplicates, and special flag counts hourly, daily, weekly and monthly.

13. Message Severity by Server, Node, and Service

A list of 15 management servers, and corresponding nodes and services on those nodes, that 
have the most associated messages; includes the following details for a selected management 
server, node and service threesome: Message age, severity, volume, duplicates, and special 
flag counts hourly, daily, weekly and monthly.

14. Message Severity by Service

A list of 15 services that have the most associated messages; for a selected service, includes 
statistics for message age, severity, volume, duplicates, and special flag counts hourly, daily, 
weekly and monthly.
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6 History Message Reports
This chapter contains brief descriptions of the reports about history messages. A history 
message can be unacknowledged or acknowledged.

1. History Dashboard by Server and Node

A list of the top 30 management server and nodes with the most severe messages and the 
most special flags.

2. History Dashboard by Server Node and Template 

A list of the top 30 management servers, nodes and templates with the most severe messages 
and the most special flags.

3. Message Age Severity Trend by Server and User

Management servers and users that have the daily messages with the longest age (where age 
refers to the amount of time that it took a user to acknowledge/clear the alarm) and details 
hourly, daily, weekly and monthly message age, severity, volume, duplicates, special flags, and 
delay in seconds for the selected management server and user pair.

4. Message OVO Server Summary

Displays message severity for each Operations management server and for the selected 
server, details message severity, age and duplicates daily, weekly and monthly.

5. Message Severity Trend by All Message 

Provides a summary of all messages across all management servers by severity and details 
message age, severity, volume, duplicates, special flag counts and delay in seconds hourly, 
daily, weekly and monthly.

6. Message Severity Trend by Application 

A list of 15 applications that have the most associated messages and details for a selected 
application the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.

7. Message Severity Trend by Message Group

A list of 15 message groups that have the most associated messages and details for a selected 
message group the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.

8. Message Severity by Node 

A list of 15 nodes that have the most associated messages and details for a selected node the 
message age, severity, volume, duplicates, special flag counts, and delay in seconds hourly, 
daily, weekly and monthly. 
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9. Message Severity by Node and Application 

A list of 15 nodes and corresponding applications on those nodes that have the most 
associated messages and details for a node and application pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

10. Message Severity by Node and Message Group 

A list of 15 nodes and corresponding message groups on those nodes that have the most 
associated messages and details for a node and message group pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

11. Message Severity Trend by Node and Template 

A list of 15 nodes and corresponding templates managing those nodes that have the most 
associated messages and details for a selected node and template pair the message age, 
severity, volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and 
monthly.

12. Message Severity Trend by Node and Service

A list of 15 nodes and corresponding services running on those nodes that have the most 
associated messages and details for a selected node and service pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

13. Message Severity Trend by Server 

A list of 15 Operations management servers that have the most associated messages and 
details for a selected Operations management server the message age, severity, volume, 
duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

14. Message Severity Trend by Server and Message Group 

A list of 15 Operations management servers and corresponding message groups being 
monitored by those servers that have the most associated messages and details for a selected 
management server and message group pair the message age, severity, volume, duplicates, 
special flag counts and delay in seconds hourly, daily, weekly and monthly.

15. Message Severity by Server and Node 

A list of 15 Operations management servers and corresponding nodes being managed by those 
servers that have the most associated messages and details for a selected management server 
and node pair the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.

16. Message Severity by Server and Service

A list of 15 Operations management servers and corresponding services being managed by 
those servers that have the most associated messages and details for a selected management 
server and service pair the message age, severity, volume, duplicates, special flag counts and 
delay in seconds hourly, daily, weekly and monthly.

17. Message Severity by Server 

A list of 15 Operations management servers and corresponding templates monitored by those 
servers that have the most associated messages and details for a selected management server 
and template pair the message age, severity, volume, duplicates, special flag counts and delay 
in seconds hourly, daily, weekly and monthly.
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18. Message Severity by Server and Application 

A list of 15 Operations management servers and corresponding applications being managed 
by those servers that have the most associated messages and details for a selected 
management server and application pair the message age, severity, volume, duplicates, 
special flag counts and delay in seconds hourly, daily, weekly and monthly.

19. Message Severity by Server, Node and Application 

A list of 15 Operations management servers and corresponding nodes and applications on 
those nodes that have the most associated messages and details for a selected management 
server, node and application threesome the message age, severity, volume, duplicates, special 
flag counts and delay in seconds hourly, daily, weekly and monthly.

20. Message Severity by Server, Node and Message Group 

A list of 15 Operations management servers and corresponding nodes and message groups 
from those nodes that have the most associated messages and details for a selected 
management server, node and message count threesome the message age, severity, volume, 
duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

21. Message Severity by Server, Node and Service 

A list of 15 Operations management servers and corresponding nodes and services on those 
nodes that have the most associated messages and details for a selected management server, 
node and service threesome the message age, severity, volume, duplicates, special flag counts 
and delay in seconds hourly, daily, weekly and monthly.

22. Message Severity by Server, Template and Condition 

A list of 15 Operations management servers and corresponding monitored templates and 
occurred conditions on those servers that have the most associated messages and details for a 
selected management server, template and condition threesome the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

23. Message Severity Trend by Server and User

A list of 15 Operations management servers and corresponding users on those servers that 
have the most associated messages and details for a selected management server and user 
pair the message age, severity, volume, duplicates, special flag counts and delay in seconds 
hourly, daily, weekly and monthly.

24. Message Severity Trend by Service 

A list of 15 services that have the most associated messages and details for a selected service 
the message age, severity, volume, duplicates, special flag counts and delay in seconds hourly, 
daily, weekly and monthly.

25. Message Severity by Template

A list of 15 templates that have the most associated messages and details for a selected 
template the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.
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26. Message Severity by Template and Condition

A list of 15 templates and corresponding occurred conditions that have the most associated 
messages and details for a selected template and condition pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and 
monthly.

27. Message Severity by User 

A list of 15 users that have the most associated messages and details for a selected user the 
message age, severity, volume, duplicates, special flag counts and delay in seconds hourly, 
daily, weekly and monthly.

28. Monthly Server Breakdown with Special Flag 

A list of the top 20 Operations management servers with the most messages with notify and 
trouble ticket details and a graph of hourly, daily, weekly and monthly special flag counts.

29. Template Breakdown with Special Flags 

A list of the top 20 templates with the most messages with notify and trouble ticket details 
and a graph of hourly, daily, weekly, and monthly special flag counts.
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7 Configuration Reports
The OVO Report Pack includes two configuration reports:

1. Notification Channels

Lists the program, service, day, starting time and ending time for each Operations 
management server notification channel for the current and previous day.

2. Trouble Ticket Channels (see sample page 46)

Shows the program, on/off flag and time period for each Operations management server for 
the current and previous day.
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Appendix A: Import and Reporting Tables
This appendix contains the following tables:

• Import tables:

— (1) History message table

— (2) Active message statistics table

— (3) Service log entries table

— (4) Configuration entries table

• Reporting tables:

— (5) History message property table

— (6) History message data tables

— (7) Consolidated message metrics by time interval

— (8) Active message property table

— (9) Active message data tables

— (10) Active message metrics by time interval

— (11) Service log property table

— (12) Service log data tables

— (13) Service log metrics by time interval
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OVO Field

CMA_FLAG

ACKN_AFTER_TT_FLAG

ACKN_TIME

ACKN_USER

APPLICATION

APPLICATION_ID

AUTO_ACKN_FLAG

AUTO_ANNO_FLAG

AUTO_CALL

AUTO_NODE_ID

AUTO_STATUS

cma_name

cma_value
1. History Message Import Table

R_OVO_MSG_BASE

K_OVO_MSG_BASE 

The following fields apply to OVO UNIX only. They do not apply to OVO Windows:
• APPLICATION_ID
• ESCALATE_FLAG
• IP_ADDRESS
• NOTIFY_SERVICES
• status_flag
• TEMPLATE_DESCRIPTION
Each field listed above is bolded in the table below.

OVPI Field  Type OVO Table(s) HISTORY OVO Table(s) ACTIVE

OPC_MSG_MESSAGES OPC_ACT_MESSAGES

ACKN_AFTER_TT_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

ACKN_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

ACKN_USER Vchar(20) OPC_MSG_MESSAGES OPC_ACT_MESSAGES

APPLICATION Vchar(254) OPC_MSG_MESSAGES OPC_ACT_MESSAGES

APPLICATION_ID Vchar(254) Opc_msg_Messages Opc_act_messages

AUTO_ACKN_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

AUTO_ANNO_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

AUTO_CALL OPC_MSG_MESSAGES OPC_ACT_MESSAGES

AUTO_NODE_ID OPC_MSG_MESSAGES OPC_ACT_MESSAGES

AUTO_STATUS OPC_MSG_MESSAGES OPC_ACT_MESSAGES

cma_name opc_MSG_cust_attrib opc_act_cust_attrib

cma_value opc_MSG_cust_attrib opc_act_cust_attrib
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CONDITION_ID

DESCRIPTION

DUPL_COUNT

ESCALATE_FLAG

FORWARD

IP_ADDRESS

LAST_TIME_RECEIVED

LOCAL_ACKN_TIME

LOCAL_AGT_CREATION_TI
ME

LOCAL_CREATION_TIME

LOCAL_LAST_TIME_RECEI
VED

LOCAL_RECEIVING_TIME

LOCAL_RECEIVING_TIME

LOCAL_UNBUFFER_TIME

LOG_ONLY_FLAG

MESSAGE_GROUP

MESSAGE_NUMBER

MESSAGE_TYPE

MSG_GEN_NODE_ID

MSG_KEY

MSG_SOURCE_NAME

OVO Field
CONDITION_ID Vchar(36) OPC_MSG_MESSAGES OPC_ACT_MESSAGES

DESCRIPTION Vchar(254) OPC_COND, 
OPC_TRAP_COND, 
OPC_MONITOR_COND

OPC_COND, 
OPC_TRAP_COND, 
OPC_MONITOR_COND

DUPL_COUNT OPC_MSG_MESSAGES OPC_ACT_MESSAGES

ESCALATE_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

FORWARD OPC_MSG_MESSAGES OPC_ACT_MESSAGES

IP_ADDRESS OPC_NODE_NAMES OPC_NODE_NAMES

LAST_TIME_RECEIVED OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_ACKN_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_AGT_CREATION_TIM
E

OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_CREATION_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_LAST_TIME_RECEIV
ED

OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_RECEIVING_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_RECEIVING_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_UNBUFFER_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOG_ONLY_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MESSAGE_GROUP OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MESSAGE_NUMBER OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MESSAGE_TYPE OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MSG_GEN_NODE_ID OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MSG_KEY OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MSG_SOURCE_NAME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OVPI Field  Type OVO Table(s) HISTORY OVO Table(s) ACTIVE
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MSG_SOURCE_TYPE

NODE_ID

NODE_NAME

NOTIFICATION_FLAG

NOTIFY_SERVICES

OBJECT

OP_INIT_ACKN_FLAG

OP_INIT_ANNO_FLAG

OP_INIT_CALL

OP_INIT_NODE_ID

OP_INIT_STATUS

RECEIVING_TIME

service_id

SERVICE_NAME

SEVERITY

status_flag

TEMPLATE_DESCRIPTION

TEMPLATE_ID

TEMPLATE_NAME

TROUBLE_TICK_FLAG

UNBUFFER_TIME

UNMATCHED_FLAG

OVO Field
MSG_SOURCE_TYPE OPC_MSG_MESSAGES OPC_ACT_MESSAGES

NODE_ID OPC_MSG_MESSAGES OPC_ACT_MESSAGES

NODE_NAME Vchar(64) OPC_NODE_NAMES OPC_NODE_NAMES

NOTIFICATION_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

NOTIFY_SERVICES OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OBJECT OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OP_INIT_ACKN_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OP_INIT_ANNO_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OP_INIT_CALL OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OP_INIT_NODE_ID OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OP_INIT_STATUS OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OVO_SERVER Vchar(16)

RECEIVING_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

service_id opc_notif_schedule opc_notif_schedule

SERVICE_NAME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

SEVERITY OPC_MSG_MESSAGES OPC_ACT_MESSAGES

status_flag opc_trouble_ticket opc_trouble_ticket

TEMPLATE_DESCRIPTION Vchar(254) opc_templ_options opc_templ_options

TEMPLATE_ID Vchar(36) opc_templ_options opc_templ_options

TEMPLATE_NAME opc_templ_options opc_templ_options

TROUBLE_TICK_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

UNBUFFER_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

UNMATCHED_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OVPI Field  Type OVO Table(s) HISTORY OVO Table(s) ACTIVE
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Comment

Created by export process

All records

All records

ONA records only

ONS records only

ONM records only

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records
2. Active Message Import Table

R_OVO_ACT_BASE

K_OVO_ACT_BASE

Column Name Data Type Description  Source Table

OVO_SERVER varchar(128) OV server records were exported 
from

NODE_NAME (based on 
NODE_ID)

varchar(254)
varchar2(1024)

 OPC_NODE_NAMES

NODE_ID (ID of node where 
event occurred)

varchar2(36) OPC_ACT_MESSAGES

APPLICATION varchar2(254) ONA records only OPC_ACT_MESSAGES

SERVICE_NAME varchar2(2048) ONS records only OPC_ACT_MESSAGES

MSG_GROUP varchar2(32) ONM records only OPC_ACT_MESSAGES

OVO_GMT_OFFSET number(12)

CNT_MESSAGES gauge/float Count of current ACTIVE 
messages

OPC_ACT_MESSAGES

CNT_UNKNOWN gauge/float With severity = 1 = unknown OPC_ACT_MESSAGES

CNT_NORMAL gauge/float With severity = 2 = normal OPC_ACT_MESSAGES

CNT_WARNING gauge/float With severity = 4 = warning OPC_ACT_MESSAGES

CNT_CRITICAL gauge/float With severity = 8 = critical OPC_ACT_MESSAGES

CNT_MINOR gauge/float With severity = 16 = minor OPC_ACT_MESSAGES

CNT_MAJOR gauge/float With severity = 32 = major OPC_ACT_MESSAGES

MIN_AGE_MSG gauge/float Minimum age of current 
ACTIVE messages

OPC_ACT_MESSAGES

MAX_AGE_MSG gauge/float Maximum age of current 
ACTIVE messages

OPC_ACT_MESSAGES
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All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

Comment
AVG_AGE_MSG gauge/float Average age of current ACTIVE 
messages

OPC_ACT_MESSAGES

TOT_AGE_MSG gauge/float Total age of current ACTIVE 
messages

OPC_ACT_MESSAGES

CNT_AGE_5_MIN gauge/float Messages less than 5 minutes 
old

OPC_ACT_MESSAGES

CNT_AGE_5_10_MIN gauge/float >= 5 minutes and < 10 minutes OPC_ACT_MESSAGES

CNT_AGE_10_30_MIN gauge/float >= 10 minutes and < 30 minutes OPC_ACT_MESSAGES

CNT_AGE_30_60_MIN gauge/float >= 30 minutes and < 60 minutes OPC_ACT_MESSAGES

CNT_AGE_60_120_MIN gauge/float >= 60 minutes and < 120 
minutes

OPC_ACT_MESSAGES

CNT_AGE_120_720_MIN gauge/float >= 120 minutes and < 720 
minutes

OPC_ACT_MESSAGES

CNT_AGE_720_1440_MIN gauge/float >= 720 minutes and < 1440 
minutes

OPC_ACT_MESSAGES

CNT_AGE_GT_1440_MIN gauge/float > 1440 minutes OPC_ACT_MESSAGES

CNT_CURR_BUFFERED gauge/float Count current buffered 
messages

OPC_ACT_MESSAGES

CNT_PREV_BUFFERED gauge/float Count messages previously 
buffered

OPC_ACT_MESSAGES

CNT_DUPL_COUNT gauge/float Total duplicates received OPC_ACT_MESSAGES

CNT_DUPL_MSG gauge/float Count of messages receiving 
duplicates

OPC_ACT_MESSAGES

CNT_ESCALATE_FLAG gauge/float Count flagged as escalated OPC_ACT_MESSAGES

CNT_AUTO_ACKN_FLAG gauge/float Count flagged as auto 
acknowledge

OPC_ACT_MESSAGES

CNT_LOG_ONLY_FLAG gauge/float Count flagged as log only OPC_ACT_MESSAGES

Column Name Data Type Description  Source Table
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All records

All records

All records

ONA

All records

ONS

Comment
CNT_NOTIFICATION_FLAG gauge/float Count flagged to send 
notification

OPC_ACT_MESSAGES

CNT_TROUBLE_TICK_FLAG gauge/float Count flagged to generate 
trouble ticket

OPC_ACT_MESSAGES

CNT_ACKN_AFTER_TT_FLA
G

gauge/float Count flagged to auto 
acknowledge after generating 
trouble ticket

OPC_ACT_MESSAGES

APPLICATION_ID Number Unique ID for long application 
names

NA

NODE_IP_ADDR Number IP Address in long form OPC_NODES

SERVICE_NAME_ID Number Unique ID for long service 
names

NA

Column Name Data Type Description  Source Table
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Comment

Created by export process

Created by export process

Created by export process

1. Unknown
2. Normal
4. Warning
8. Critical
16. Minor
32. Major

TA_PERIOD

Created by export process

Created by export process

Created by export process
3. Service Log Import Table

R_OVO_SRVLOG_BASE

K_OVO_SRVLOG_BASE

Column Name Data Type Column Sample Data  OVO Source Table

SPLIT_FLAG number

ORIG_TA_PERIOD date 18/6/2007 10:03:43 PM

OVO_SERVER varchar(128)

SERVICE_NAME varchar2(2048) SeM_SPI:Server@@nsprod01 OPC_SERVICE_LOG

SEVERITY number(3) 4 OPC_SERVICE_LOG

START_TIME number(12) 1108624087 OPC_SERVICE_LOG

LOCAL_START_TIME date 4/5/2005 10:03:43 PM OPC_SERVICE_LOG

END_TIME number(12) 1108624087 OPC_SERVICE_LOG

LOCAL_END_TIME date 4/5/2005 11:03:43 PM OPC_SERVICE_LOG

DURATION number(12) 1108624087

OVO_GMT_OFFSET number(12)

EXPORT_TIME number(12) 1108594373
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R_OVO_SRVLOG_BASE [?]

K_OVO_SRVLOG_BASE [?]

The metrics in the following table are available from OVOU only. They are not available from 
OVOW. The following reports are affected:
• Notif_Channels.rep
• TT_Channels.rep

Column Name OVOU Source Table Comment

dsi_key_id_ Standard OVPI numeric element ID

ta_period Standard OVPI time stamp

delta_time Standard OVPI column not used in this case

ta_samples Standard OVPI column. Always 1 in this 
case

OVO_SERVER Created by export process

Type Record type indicator TT or NOTIF

NOTIF_SVC_ID Opc_notif_services Service Identifier

NOTIF_SVC_NAME Opc_notif_services Notif Service Name

FLAG opc_trouble_ticket Active/Inactive

PROGRAM Opc_notif_services

opc_trouble_ticket External program

DAY opc_notif_schedule Day for Notif

STARTING opc_notif_schedule Start time for Notif channel

ENDING opc_notif_schedule End time for Notif channel
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_OVO_MSG.
5. History Message Property Table

All OVO Consolidated Message summarized data tables are associated with the K_OVO_MSG property tableK

Column Name Data Type Population Method

dsi_key_id Maintained by OVPI

dsi_target_name Record type indicator based on trend_sum by variables:
O: OVO_SERVER
ON: OVO_SERVER - NODE_NAME 
OA: OVO_SERVER - APPLICATION
OS: OVO_SERVER - SERVICE_NAME
OM: OVO_SERVER - MSG_GROUP
OU: OVO_SERVER – ACKN_USER
OT: OVO_SERVER – TEMPLATE
OTD: OVO_SERVER – TEMPLATE - DESCRIPTION
ONA: OVO_SERVER – NODE_NAME - APPLICATION
ONS: OVO_SERVER – NODE_NAME - SERVICE_NAME
ONM: OVO_SERVER – NODE_NAME - MSG_GROUP
All Msgs (executive summary across all messages)
A: APPLICATION
S: SERVICE_NAME
M: MSG_GROUP
U: ACKN_USER
T: TEMPLATE
TD: TEMPALTE – DESCRIPTION
N: NODE
NT: NODE – TEMPLATE
NS: NODE – SERVICE
NA: NODE – APPLICATION
NM: NODE – MSG GROUP
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”

dsi_table_key Due to custom rollup, all by variables, except for 
GRP_LEVEL and the interval by variable, are concatenated
and inserted into dsi_table_key

dsi_status number(3,0) Specifies the global status attribute for the managed object
The default value is 2.

dsi_status_time date Contains the timestamp of the last status. The default valu
is the current time.

dsi_descr Set to same value as dsi_table_key 

GRP_LEVEL Same as dsi_target_name

OVO_SERVER Varchar(128) trend_sum populates based on by variable “OVO_SERVER”

NODE_NAME Varchar(254)
Varchar2(1024)

trend_sum populates based on by variable “NODE_NAME”

APPLICATION Varchar2(254) trend_sum populates based on by variable “APPLICATION

SERVICE_NAME Varchar2(2048) trend_sum populates based on by variable 
“SERVICE_NAME”

ACKN_USER Varchar2(20) trend_sum populates based on by variable “ACKN_USER”

MESSAGE_GROUP VARCHAR(255) trend_sum populates based on by variable “MSG_GROUP”

MSG_SOURCE_NAME VARCHAR(255) trend_sum populates based on by variable “TEMPLATE”

APPLICATION_ID number Unique hash for application

COND_DESCRIPTION_ID number Unique hash for condition description

SERVICE_NAME_ID number

CONDITION_DESCR VARCHAR(255) trend_sum populates based on by variable “CONDITION”

OTHER standard columns 
found in OVPI RPs

Column Name Data Type Population Method
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6. History Message Data Table

7. Consolidated Message Metrics by Time Period

Destination Table Rollup Processing Populating Table

SH_OVO_MSG Populated by several roll-up combinations: SH_OVO_MSG.nnn

SD_OVO_MSG Populated by trend_sum using SD_OVO_MSG.sum

SW_OVO_MSG Populated by trend_sum using SW_OVO_MSG.sum

SM_OVO_MSG Populated by trend_sum using SM_OVO_MSG.sum

Metric Hour Day Week Month

CNT_MESSAGES X X X X

CNT_UNKNOWN X X X X

CNT_NORMAL X X X X

CNT_WARNING X X X X

CNT_CRITICAL X X X X

CNT_MINOR X X X X

CNT_MAJOR X X X X

MIN_RECEIVE_DELAY X X X X

MAX_RECEIVE_DELAY X X X X

AVG_RECEIVE_DELAY X X X X

TOT_RECEIVE_DELAY X X X X

MIN_AGE_MSG X X X X

MAX_AGE_MSG X X X X
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AVG_AGE_MSG X X X X

TOT_AGE_MSG X X X X

CNT_AGE_5_MIN X X X X

CNT_AGE_5_10_MIN X X X X

CNT_AGE_10_30_MIN X X X X

CNT_AGE_30_60_MIN X X X X

CNT_AGE_60_120_MIN X X X X

CNT_AGE_120_720_MIN X X X X

CNT_AGE_720_1440_MIN X X X X

CNT_AGE_GT_1440_MIN X X X X

CNT_PREV_BUFFERED X X X X

CNT_DUPL_COUNT X X X X

CNT_DUPL_MSG X X X X

CNT_ESCALATE_FLAG X X X X

CNT_AUTO_ACKN_FLAG X X X X

CNT_LOG_ONLY_FLAG X X X X

CNT_NOTIFICATION_FLAG X X X X

CNT_TROUBLE_TICK_FLAG X X X X

CNT_ACKN_AFTER_TT_FLAG X X X X

Metric Hour Day Week Month
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8. Active Message Property Table

All OVOu Active Message summarized data tables are associated with the K_OVO_ACT property table.

K_OVO_ACT

Column Name Data Type Population Method

dsi_key_id Maintained by OVPI

dsi_target_name ON: OVO_SERVER - NODE_NAME 
OS: OVO_SERVER - SERVICE_NAME
OM: OVO_SERVER - MSG_GROUP
ONA: OVO_SERVER – NODE_NAME - APPLICATION
ONS: OVO_SERVER – NODE_NAME - SERVICE_NAME
ONM: OVO_SERVER – NODE_NAME - MSG_GROUP
All Msgs executive summary across all messages
A: APPLICATION
S: SERVICE_NAME
M: MSG_GROUP

node_id varchar2(128) Unique ID of node where event occurred.

dsi_status number(3,0) Specifies the global status attribute for the managed object. 
The default value is 2.

dsi_status_time date Contains the timestamp of the last status. The default value 
is the current time.

dsi_table_key Due to custom rollup, all by variables, except for 
GRP_LEVEL and the interval by variable, will be 
concatenated and inserted into dsi_table_key

dsi_descr NULL. Not used

GRP_LEVEL Same as dsi_target_name

OVO_SERVER varchar(128) trend_sum populates based on by variable “OVO_SERVER”

NODE_NAME varchar(254) 
archar2(2048)

trend_sum populates based on by variable “NODE_NAME” 
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9. Active Message Data Table

10. Active Message Metrics By Time Interval

APPLICATION varchar2(254) trend_sum populates based on by variable “APPLICATION”

SERVICE_NAME varchar2(2048) trend_sum populates based on by variable 
“SERVICE_NAME”

MSG_GROUP varchar2(32) trend_sum populates based on by variable “MSG_GROUP”

APPLICATION_ID Number Unique hash for the application

SERVICE_NAME_ID Number Unique hash for the service

OTHER standard 
columns found in OVPI 
RPs

Destination Table Rollup Processing Populating Table

SH_OVO_ACT Populated by several roll-up combinations: SH_OVO_ACT.nnn

SD_OVO_ACT Populated by trend_sum using SD_OVO_ACT.sum

SW_OVO_ACT Populated by trend_sum using SW_OVO_ACT.sum

SM_OVO_ACT Populated by trend_sum using SM_OVO_ACT.sum

Metric Hour Day Week Month

CNT_MESSAGES X X X X

CNT_UNKNOWN X X X X

CNT_NORMAL X X X X

Column Name Data Type Population Method
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CNT_WARNING X X X X

CNT_CRITICAL X X X X

CNT_MINOR X X X X

CNT_MAJOR X X X X

MIN_AGE_MSG X X X X

MAX_AGE_MSG X X X X

AVG_AGE_MSG X X X X

TOT_AGE_MSG X X X X

CNT_AGE_5_MIN X X X X

CNT_AGE_5_10_MIN X X X X

CNT_AGE_10_30_MIN X X X X

CNT_AGE_30_60_MIN X X X X

CNT_AGE_60_120_MIN X X X X

CNT_AGE_120_720_MIN X X X X

CNT_AGE_720_1440_MIN X X X X

CNT_AGE_GT_1440_MIN X X X X

CNT_CURR_BUFFERED X X X X

CNT_PREV_BUFFERED X X X X

CNT_DUPL_COUNT X X X X

CNT_DUPL_MSG X X X X

CNT_ESCALATE_FLAG X X X X

CNT_AUTO_ACKN_FLAG X X X X

CNT_LOG_ONLY_FLAG X X X X

Metric Hour Day Week Month
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CNT_NOTIFICATION_FLAG X X X X

CNT_TROUBLE_TICK_FLAG X X X X

CNT_ACKN_AFTER_TT_FLAG X X X X

Metric Hour Day Week Month
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11. Service Log Property Table

All OVOu Service Log summarized data tables are associated with the K_OVO_SRVLOG property table.

K_OVO_SRVLOG

12. Service Log Data Tables

The following OVOu Service Log rollup tables are used for reporting:

Column Name Population Method

dsi_key_id Maintained by OVPI

dsi_target_name trend_sum populates based on by variable “OVO_SERVER”

dsi_table_key trend_sum populates based on by variable “SERVICE_NAME”

dsi_descr NULL. Not used

OVO_SERVER trend_sum populates based on by variable “OVO_SERVER”

SERVICE_NAME trend_sum populates based on by variable “SERVICE_NAME”

Destination Table Rollup Processing Populating Table

SD_OVO_SRVLOG populated by trend_sum using SD_OVO_SRVLOG.sum

SW_OVO_SRVLOG populated by trend_sum using SW_OVO_SRVLOG.sum

SM_OVO_SRVLOG populated by trend_sum using SM_OVO_SRVLOG.sum
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 13. Service Log Metrics by Time Interval

Metric Day Week Month

CNT_MESSAGES X X X

DURATION_TOTAL X X X

DURATION_UNKNOWN X X X

DURATION_NORMAL X X X

DURATION_WARNING X X X

DURATION_CRITICAL X X X

DURATION_MINOR X X X

DURATION_MAJOR X X X



B PI Report Packs
Business Technology Reporting Solution

Application Server • Application Server Report Pack
— WebLogic SPI
— WebSphere SPI

Database SPI • Database Report Pack

HP Business Process Insight • BPI Report Pack

HP Internet Services • Internet Services Report Pack

HP Network Node Manager • NNM Event & Availability Report Pack

HP Service Desk • Service Desk Report Pack
• Change Management Report Pack
• SLM Integration Report Pack

HP Sitescope • Sitescope Report Pack

IP Telephony • Cisco IP Telephony Call Detail
• Cisco IP Telephony Gateway Statistics

MPLS VPN • MPLS VPN Report Pack

Networking Traffic Profiling

• RMON II

• NetFlow Interface

• NetFlow Global View

• IP QoS Report Pack

• Class-Based QoS Report Pack

Quality Assurance

• Cisco Ping 
• Service Assurance
• IP Access Rate

Infrastructure Usage

• Interface Reporting
• Device Resource
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Networking (con’t) LAN/WAN Edge

• Frame Relay (SNMP only) 
• ATM (SNMP only)

WAN Core

• Frame Relay (multiple switch vendors)
• ATM (multiple switch vendors)

System Resources • System Resource Report Pack

Business Technology Reporting Solution
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C Version History
Version/date released New features and defect fixes

1.0 / May 2006 Total of 47 reports:
Active folder (14)
Message Weekly folder (3)
Config folder (2)
Message folder (27)
Service Log folder (1)
The OVOu Datapipe 1.0 collects data from:
• OVOu 7.0 
• OVOu 8.0

1.1 / April 2007 new features:
Location Independent Reporting (LIR)
new datapipe:
OVOu Datapipe 1.1
defect fixes:
• QXCR1000401476: Mapping between 

managed_nodes and Customers & Locations
• QXCR1000371765: OVO RP 

update_OVO_MSG_props.sql hanging on 
Oracle.

• QXCM1000353122: OVOu datapipe not 
collecting data.

• QXCR1000381445: Multiple issues with 
OVOu datapipe.

• QXCR1000384269: OVO datapipe problem 
when multiple cma pairs.

1.2 / October 2007 new datapipe:
• OVO Datapipe 1.2
new data collection:
• OVOw 7.5
• OMu 8.0
new upgrade package:
• UPGRADE_OVO_to_12.p
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Add Database Wizard, 21, 22

C
CD containing report packs

extracting packages, 16

Common Property Tables
upgrade rules, 17
upgrading, 16

Copy Policy Manager, 40

D
Daily_OVO_ACT_Rollup.pro file, 41

Daily_OVO_CONFIG_Rollup.pro file, 41, 42

Daily_OVO_MSG_Rollup.pro file, 41

Daily_OVO_Rollup.pro file, 31

Daily_OVO_SRVLOG_Rollup.pro file, 41, 42

data export, 9

demo package, 13
installing, 17

E
export program

database parameter, 29
datadir parameter, 29
dataset parameter, 29
debug parameter, 29
help parameter, 29
prevdays parameter, 29
server parameter, 29
testing, 30
version parameter, 29
v parameter, 29

export views, 10, 27
RV_OVO_MSG_BASE_A, 10
RV_OVO_MSG_BASE_ON, 10
RV_OVO_MSG_BASE_OTD, 10

extracting packages from distribution CD, 16

I
installation of report pack, 16

L
LIR configuration, 39

O
OVO_Datapipe_Daily.pro file, 31

OVO_Datapipe_Hourly.pro file, 31, 32

ovou7servers.prp, 27, 28

ovou8servers.prp, 27, 28

OVPI Timer
restarting, 17
stopping, 16

P
Package Manager, 17

package removal, 35

process files
Daily_OVO_ACT_Rollup.pro, 41
Daily_OVO_CONFIG_Rollup.pro, 41, 42
Daily_OVO_MSG_Rollup.pro, 41
Daily_OVO_Rollup.pro, 31
Daily_OVO_SRVLOG_Rollup.pro, 41, 42
OVO_Datapipe_Daily.pro, 31
OVO_Datapipe_Hourly.pro, 31, 32

R
removing packages, 35

report pack CD
extracting packages, 16

reports
active message reports, 43
configuration reports, 85
deploying, 17
history message reports, 63
uninstalling, 35
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Sybase limitation, 9

systems.xml, 27, 28

T
trendtimer.sched file, 31, 40

U
uninstalling report pack, 35

upgrading Common Property Tables, 16
rules, 17
112


	User Guide
	Contents
	1 Overview
	HP Performance Insight
	The OVO Report Pack
	Enhancements in Version 1.2
	Data Collection
	Sybase Limitation
	Data Export


	Folders and Reports
	Metrics Not Available from OVOw
	Background on OVO Message Generation
	What are Active Messages?
	What are History Messages?
	What is a Message Group?
	What is an Application?

	Sources for Additional Information

	2 Installation and Configuration
	Guidelines for a Smooth Install/Upgrade
	Supported Environments
	Common Property Tables
	Are You Upgrading to Version 1.2?

	Using Package Manager to Install OVO Reporting
	Configuration Steps
	Task 1: Open the TCP/IP Protocol on the OMw Server (applies to OMw 8.0 only)
	Task 2: Add an External OVO Database to OVPI
	Task 3: Register OVO Servers with the OVO Datapipe
	Task 4: Configuring OVO for Active Message Export
	How the Export Program Operates
	Export Program Parameters

	Testing the Export Process


	3 Verification Steps
	Collection and Rollup Entries in trendtimer.sched
	Correct Deployment of Reports
	The Data Export Program is Working
	OVPI Is Importing Data
	The Hourly Data Tables Are Populated
	The Daily Tables Are Populated
	Uninstalling the OVO Report Pack

	4 Setting Up a Distributed System
	Overview of the Steps
	Verifying Correct Package Installation
	Configuring the Central Server
	Configuring Satellite Servers
	System Clocks

	5 Active Message Reports
	6 History Message Reports
	7 Configuration Reports
	Appendix A: Import and Reporting Tables
	1. History Message Import Table
	2. Active Message Import Table
	3. Service Log Import Table
	4. Configuration Import Table
	5. History Message Property Table
	6. History Message Data Table
	7. Consolidated Message Metrics by Time Period
	8. Active Message Property Table
	9. Active Message Data Table
	10. Active Message Metrics By Time Interval
	11. Service Log Property Table
	12. Service Log Data Tables
	13. Service Log Metrics by Time Interval

	B PI Report Packs
	C Version History
	Index



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


